

HƯỚNG DẪN SỬ DỤNG MONTANA 680


I. THÔNG SỐ KỶ THUẬT:

 (
Trung Tâm Trắc Địa Miền Bắc          
  
 Hot line:0898.9282.222 – 0399.758.755
)

 (
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· Kích thướt máy
· Kích thướt màn hình
· Độ phân giải màn hình
· Loại màn hình
· Trọng lượng
· Nguồn điện sử dụng
· Thời gian sử dụng pin
· Chống thấm

: 7.48 x 14.42 x 3.64 cm
: 5.06 x 8.93 cm (4.0”)
: 272 x 480 pixels
: Cảm ứng, tinh thể lỏng 65 ngàn màu.
: 289 gram (kể cả pin Lithium-ion)
: Pin sạc Lithium-ion (kèm theo máy) hoặc 3 pin AA
: khoảng 16 giờ (pin Lithium-ion) hoặc 22 giờ (với pin AA)
: đạt tiêu chuẩn IPX7

· Hệ bản đồ	: WGS 84, VN 2000, … và nhiều hệ bản đồ khác
· Hệ tọa độ	: UTM, Lat/Long, Maiden head, MGRS,…

· Độ nhạy máy thu
· Dãy nhiệt độ hoạt động
· Giao diện với máy tính

: mạnh và cực nhanh, sai số từ 3-10 mét
: từ -15 độ C đến 70 độ C
: USB tốc độ cao và tương thích với chuẩn NMEA 0183

· Cài đặt sẳn bản đồ hành chính các tỉnh/thành trong cả nước.
· Dung lượng bộ nhớ trong: 4.0 GB
· Hổ trợ khe cắm thẻ nhớ ngoài, loại thẻ Micro SD (không kèm theo máy)
· Có khả năng tải bản đồ vào máy, tương thích với chức năng Custom Map
· Bộ nhớ điểm (waypoint): 4000 điểm

· Hành trình: thiết lập được 200 hành trình, mỗi hành trình có thể
· Bộ nhớ lưu vết: 10.000 điểm, có thể lưu được 200 Saved Track

đi qua 200 điểm

· Chức năng Routing: dẫn đường theo tuần tự nếu đã cài đặt bản đồ giao thông
· Dẫn đường bằng hình ảnh (photo navigation)
· La bàn điện tử và khí áp kế đo cao độ bên trong máy
· Tích hợp máy ảnh kỷ thuật số 8.0 megapixel, tự động gắn toạ độ vào bức ảnh
· Chia sẽ dữ liệu với các GPS tương thích khác bằng wireless
· Lịch vệ tinh (tìm thời gian đo tốt nhất)
· Thông tin mặt trăng, mặt trời và lịch thủy triều
· Tính toán chu vi, diện tích ngay trên máy
· Chức năng cảnh báo vào vùng nguy hiểm
· Chức năng trình duyệt ảnh kỷ thuật số

II. HÌNH ẢNH BÊN NGOÀI: Hình mặt trước và mặt sau:


	[image: ]

	1
	Thấu kính máy ảnh

	2
	Nút nguồn

	3
	Khe cắm thẻ nhớ (bên dưới hộp pin)

	4
	Nơi lắp đế nguồn gắn trên ôtô

	5
	Jack cắm headphone

	6
	Cổng USB

	7
	Khóa mở hộp pin

	8
	Cổng anten ngoài




III. MỞ, TẮT MÁY & CÁC CHẾ ĐỘ MÀN HÌNH:

[image: ]1/ Nhấn và giữ phím [image: ]  khoảng 3 giây để tắt hoặc mở máy.
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2/ Chỉnh độ sáng của màn hình: Nhấn nhẹ phím trên màn hình để điều chỉnh độ sáng cho thích hợp.

, sau đó di chuyển thanh trượt

3/ Khoá màn hình: do là màn hình cảm ứng và để tránh những kích hoạt ngoài ý muốn, ta có thể khoá màn hình lại:
· [image: ]Nhấn [image: ]
· Chọn

Để mở khoá màn hình, ta cũng làm tương tự như trên
IV. CÁCH SỬ DỤNG CÁC PHÍM ẢOTRÊN MÀN HÌNH CẢM ỨNG:


· Chọn
· Chọn
· Chọn
· Chọn
· Chọn
· Chọn
· Chọn

[image: ]  để mở tất cả các ứng dụng trên màn hình menu chính
để đóng trang màn hình hiện tại và trở về trang màn hình trước đó. để trở về trang màn hình trước đó.
để lưu lại những thay đổi và đóng trang màn hình lại. và [image: ] để di chuyển màn hình lên hay xuống.
để mở một menu phụ để tìm kiếm.



V. MÀN HÌNH MENU CHÍNH:


Tất cả các tính năng của máy đều nằm trên màn hình Menu chính. Dùng phím   [image: ]   hoặc
để chuyển đổi giữa các trang màn hình với nhau. Trên mỗi chức năng, ta có thể ấn để mở Menu phụ  cho chính chức năng đó. Các trang màn hình Menu chính gồm có
như hình bên dưới:
[image: ][image: ]


[image: ]	[image: ]
CÀI ĐẶT

I. CÀI ĐẶT CHO HỆ THỐNG:

Từ màn hình Menu chính, chọn Setup > System. Bạn sẽ có các lựa chọn sau:
· Satellite: nên chọn GPS + GLONASS
· Text language: chọn English.
· Voice Language: chọn American English-Jill II. CÀI ĐẶT CÁC ĐƠN VỊ ĐO LƯỜNG:
Từ màn hình Menu chính, chọn Setup > Units, ta có hình như bên dưới. Sau đó, có thể cài đặt các đơn vị đo lường theo ý muốn của người sử dụng.
[image: ]

III. CÀI ĐẶT THỜI GIAN: Từ màn hình Menu chính, chọn Setup > Time :

· Time Format: chọn chế độ 12-hours hoặc 24-hours
· Time Zone: chọn Automatic, máy sẽ tự động chọn múi giờ cho bạn


IV. CÀI ĐẶT HỆ TỌA ĐỘ & HỆ BẢN ĐỒ: Từ màn hình Menu chính, chọn Setup > Position Format :
[image: ]
· Chọn hddd’mm.mmm’ : nếu bạn muốn xem tọa độ dưới dạng độ, phút, giây
· Chọn UTM / UPS : nếu bạn muốn xem tọa độ dưới dạng mét.

Map Datum: chọn WGS 84

* Ngoài ra, nếu bạn muốn cài đặt hệ tọa độ VN 2000, thao tác như sau: Chọn Setup > Position Format > Map Datum > User. Ta có màn hình:
[image: ]

Sau đó nhập các giá trị của DX, DY, DZ vào:

DX = - 00193, DY = - 00039, DZ = - 00111

Nhập xong, chọn [image: ]

để lưu lại các giá trị trên, nhấn [image: ]

để thoát khỏi màn hình này.


Sau đó chọn lại Position Format > Position Format > User Grid > UTM và nhập các giá trị dưới đây vào :








· False Easting : Đổi giá trị thành 500000.0m
· False Northing: Đổi giá trị thành 0.0m
· Scale: giữ nguyên giá trị hoặc đổi thành 0.9999000, tùy theo lưới chiếu sử dụng.
· Longitude Origin: nhập kinh tuyến trục của địa phương vào.

 (
Công ty TNHH máy đo đạc Hải Phòng /Đc: 60 Hùng Vương – Hồng Bàng – Hải Phòng
Website: maydodachaiphong.com/ Email: 
maydodachp@gmail.com
 
Hotline: 0965 652 199/ 0316292 468
)


Nhập xong mỗi giá trị chọn nhập các giá trị tiếp theo.

[image: ]  để lưu lại. Sau đó chọn [image: ]

để thoát ra và tiếp tục


Lưu ý: Nhớ chuyển chữ W thành E trước giá trị của kinh tuyến trục (xem danh sách kinh tuyến gốc của tất cả các tỉnh thành ở phần cuối)



CÁC THAO TÁC THƯỜNG SỬ DỤNG I. ĐO VÀ LƯU LẠI MỘT TỌA ĐỘ ĐIỂM (Waypoint):
Sau khi mở máy, đợi vài giây cho máy thu được tín hiệu vệ tinh. Chọn Sattelite để kiểm tra, khi nào máy thu được tín hiệu vệ tinh như màn hình bên dưới - khi đó máy đã

Tọa độ nơi đặt máy


Sai số



sẳn sàng hoạt động. Máy có thể đo và lưu trữ được 4.000 tọa độ điểm với tên và biểu
tượng khác nhau.
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[image: ]


1/ Đo và lưu lại vị trí đang đặt máy:

· Mở máy và chờ thu tín hiệu từ vệ tinh, đặt máy tại vị trí cần đo.
· Nhấn vào lệnh Mark Waypoint
· Chọn Save để lưu thông tin vào máy. Máy sẽ tự động lưu lại tên tọa độ điểm theo dạng số thứ tự 1, 2, 3 …. Nếu thích, bạn có thể chọn lệnh Edit để đặt lại tên và biểu tượng cho từng vị trí.
[image: ]


2/ Lưu lại 1 tọa độ bất kỳ:
 (
Công ty TNHH máy đo đạc Hải Phòng /Đc: 60 Hùng Vương – Hồng Bàng – Hải Phòng
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· Việc đầu tiên là ghi lại tọa độ cần lưu ra giấy.
· Chọn lệnh Mark Waypoint
· Chọn lệnh Edit
· [image: ]Chọn Location, máy sẽ hiện ra 1 bảng chữ số, sử dụng bảng chữ số này và các mũi tên để nhập tọa độ mới vào.
· Nhấn	để hòan tất việc nhập dữ liệu
· Chọn Save để lưu lại

3/ Đo 1 tọa độ giả định:

Chức năng này dùng để đo tọa độ bất kỳ một điểm nào mà ta thấy trên màn hình bản đồ, hoặc ta nhìn thấy ngòai thực địa nhưng không thể đến ngay vị trí đó được (VD: nằm giữa ao, hồ hoặc địa hình hiểm trở,…)
· Chọn Map để đưa về màn hình bản đồ.
· Chạm vào vị trí trên bản đồ mà ta cần lưu lại (cần phóng to bản đồ càng lớn càng tốt, như vậy vị trí cần lưu sẽ chính xác hơn)
· [image: ]Trên đỉnh màn hình sẽ hiện ra một dòng thông tin. Chạm tiếp vào dòng thông tin đó, trên đỉnh màn hình sẽ hiện ra tọa độ, cao độ và khỏang cách đến điểm mà ta cần lưu.
· Chạm vào hình	để lưu lại tọa độ điểm đó. Nhấn OK để hòan tất công việc.




[image: ]




4/ Hiệu chỉnh Waypoint:


Sau khi đã lưu Waypoint vào bộ nhớ, bạn có thể hiệu chỉnh để thay đổi tên, biểu tượng, tọa độ, cao độ, hình ảnh… của một Waypoint bất kỳ.
· Vào Waypoint Manager
· Chọn 1 Waypoint mà ta cần hiệu chỉnh.
· Chọn 1 thuộc tính cần hiệu chỉnh như tên,biểu tượng, tọa độ, Elevation: cao độ,..
· Chọn chữ, con số, biểu tượng cần thiết cho sự thay đổi

· Nhấp vào hình
· Nhấp vào hình

để hòan tất việc hiệu chỉnh để thóat khỏi chức năng này.

5/ Xóa Waypoint:

a/ Xóa 1 Waypoint:
· Vào Waypoint Manager
· Chọn 1 Waypoint mà bạn cần xóa
· Chọn biểu tượng [image: ]
· Chọn Delete. Máy sẽ hiện ra 1 câu hỏi, tiếp tục chọn Delete : điểm đã được xoá

b/ Xóa tất cả Waypoint:
Hết sức cẩn thận khi sử dụng chức năng này, một khi dữ liệu đã bị xoá thì không thể khôi phục lại được. thao tác như sau:

Chọn Setup > Reset > Delete All Waypoints > Delete

Khi bạn xóa bỏ 1 Waypoint nào đó, thì hình ảnh gắn liền với Waypoint đó vẫn chưa
được xóa. Muốn xóa hình ảnh, bạn phải vào Photo Viewer. II. SỬ DỤNG MÁY CHỤP ẢNH (Camera):
Montana 650 có tích hợp 1 Camera 5.0 Megapixel. Khi bạn chụp ảnh, hình ảnh sẽ được lưu lại cùng với tọa độ của bức ảnh. Bạn có thể dùng chức năng dẫn đường để tìm vị trí bức ảnh giống như tìm một Waypoint.

1/ Cài đặt cho máy ảnh:

Chọn Setup > Camera, ta có hình như bên dưới



[image: ]


2/ Chụp ảnh:

· Chọn Camera
· Nếu cần thiết, có thể chạm vào biểu tượng thích hợp.



[image: ]  để chọn chế độ




ánh sáng cho

· [image: ]Chạm vào dấu + hoặc – , để chọn chế độ chụp xa hay gần
· [image: ]Chạm nhẹ vào biểu biểu tượng	để chụp bức ảnh
· Chạm vào	để thóat khỏi Camera


3/ Xem lại bức ảnh đã chụp:

· Chọn Photo Viewer
· Chọn bức ảnh cần xem
· Chạm vào biểu tượng [image: ]





, ta có các lựa chọn sau:

+ View Map: xem vị trí bức ảnh trên bản đồ
+ View Information: xem thông tin về bức ảnh như toạ độ, ngày chụp,…
+ Delete Photo: xóa ảnh
+ Set As Wallpaper: chọn ảnh làm hình nền


[image: ]

III. SỬ DỤNG LA BÀN ĐIỆN TỬ:

Màn hình la bàn thường dùng để dẫn đường. Khi bạn cần di chuyển đến 1 điểm
nào đó, phần mũi nhọn của ▲ luôn luôn chỉ về điểm mà bạn cần đi đến, bất chấp
hướng mà bạn đang di chuyển. Nếu mũi tên chỉ về đỉnh của la bàn, khi đó bạn đã đi đúng hướng.
Ở màn hình này còn cung cấp cho bạn các thông số như : tốc độ hiện tại, khoảng cách đến điểm đến và thời gian dự kiến kết thúc hành trình.

1/ Hiệu chỉnh lại la bàn:

Trong quá trình sử dụng nếu thấy la bàn trong máy lệch so với thực tế, ta nên hiệu chỉnh lại. Mặt khác, nên hiệu chỉnh lại la bàn điện tử sau khi bạn đã di chuyển 1 khoảng cách xa hoặc có sự thay đổi nhiều về nhiệt độ (từ 11 độ C). Việc này ta nên làm ở ngoài trời và không nên đứng gần những vật có phát ra từ trường (xe ô tô, đường dây điện,...). Thao tác như sau:

· [image: ]Vào Setup > Heading > Calibrate Compass, nhấn
Start. Sau đó làm theo như minh họa trên màn hình.

Hoặc:

· Chọn Compass, la bàn sẽ xuất hiện. Sau đó, cầm và

giữ

ngay giữa la bàn, nhấn

Start và làm theo minh

họa trên màn hình.

Nếu xuất hiện dòng chữ “Calibration Failed” - quá trình

hiệu chỉnh chưa đạt. Bạn phải nhấn trình.

Ok và lặp lại quá






2/ Hiệu chỉnh Sensor đo cao độ:

Để máy có thể đo cao độ chính xác hơn (độ cao so với mặt nước biển), bạn nên hiệu chỉnh lại thiết bị. Ta phải đi đến nơi mà ta biết chính cao độ hoặc áp suất để hiệu chỉnh. Máy sẽ căn cứ vào cột mốc chuẩn này để đo chính xác hơn các điểm về sau.

· Vào Setup > Altimeter > Calibrate Altimeter
· [image: ]Nhấn Yes nếu bạn biết cao độ. Nhấn No, sau đó chọn Yes nếu bạn biết áp suất.
· Sau đó nhập giá trị cao độ hoặc áp suất vào. Nhấn	để hòan tất công việc
[image: ][image: ]


*Chú ý: đơn vị đo cao độ và áp suất phải tương ứng với các đơn vị đo lường mà bạn đã chọn ở phần cài đặt.

IV. HÀNH TRÌNH (Route):

Hành trình là bao gồm một chuổi các tọa độ điểm mà nó dẫn bạn đi từ điểm đầu tiên đến đến điểm cuối cùng, một hành trình phải có ít nhất 2 điểm.Thiết bị này có thể lưu được 200 hành trình, mỗi hành trình có thể đi qua được 200 tọa độ điểm.

1/ Thiết lập một hành trình:

· Bước 1: Vào Route Planner > Create Route > Select First Point : chọn điểm khởi hành cho hành trình.
· Bước 2: Chọn 1 trong các tùy chọn sau:

+ Use Map: màn hình bản đồ hiện ra, chạm vào bất kỳ điểm nào mà bạn muốn.
+ Recent Finds: những điểm được lưu trong thời gian gần nhất
+ Waypoint: máy sẽ hiện ra danh sách Waypoint đã lưu trong máy, hãy chọn cho bạn một Waypoint.
+ Photos: Chọn 1 hình ảnh.
· Bước 3 : Chọn Use: máy sẽ chọn 1 trong các tùy chọn ở trên làm điểm khởi hành.
· Bước 4 : Chọn Select Next Point: chọn điểm kế tiếp cho hành trình.
· [image: ]Bước 5 : lặp lại bước 2 và 3 cho đến khi bạn chọn xong điểm kết thúc hành trình.
· Bước 6 : Nhấn	để thoát ra và lưu lại hành trình.


2/ Xem lại một hành trình trên bản đồ:


· Vào Route Planner
· Chọn 1 hành trình mà bạn muốn xem. Nhấn hiện ra trên bản đồ.

3/ Chỉnh sửa một hành trình:


View Map: hành trình của bạn sẽ


Có thể chỉnh sửa lại bất cứ hành trình nào mà bạn đã tạo trước đó.
· Vào Route Planner
· Chọn một hành trình mà bạn muốn chỉnh sửa
· Chạm vào một điểm mà bạn muốn chỉnh sửa, sẽ có các tùy chọn sau:
+ Review: xem thông tin của của điểm đó: tọa độ, cao độ , khoảng cách đến.
+ Move Down (or Up) : thay đổi thứ tự của điểm trên hành trình.
+ Insert: thêm một điểm mới vào hành trình

+ Remove: lọai bỏ 1 điểm ra khỏi hành trình

4/ Hành trình ngược:

Bạn có thể đảo chiều một hành trình, khi đó điểm khởi đầu sẽ là điểm kết thúc của hành trình và thứ tự các điểm trong hành trình cũng được đổi theo tương ứng. Sử dụng chức năng này khi ta đã đi hết một hành trình và muốn trở về trên con đường đã đi trước đó.
· Vào Route Planner
· Chọn hành trình mà bạn muốn đảo chiều > chọn Reverse Route 5/ Xóa một hành trình:
· Vào Route Planner
· Chọn 1 hành trình cần xóa, nhấn Delete Route > Delete V. TRACK (Vết, đường đi):
Tất cả các thiết bị GPS của Garmin sẽ ghi lại dấu vết (Track) trong quá trình di chuyển. Bạn có thể lưu lại những track này để sử dụng sau đó. Thiết bị này có thể lưu lại được 200 Track.


1/ Quản lý Track Log:

· Từ Menu chính, chọn Setup > Tracks > Tracks Log
· Chọn Record Method, Distance hoặc Record Method, Time hoặc Auto
Nếu bạn chọn Distance/Time : Track của bạn sẽ tự động lưu theo khoảng cách/thời gian chỉ định.

2/ Xem Track hiện tại:

Track đang được ghi gọi là track hiện tại

Từ menu chính, chọn Current Track hoặc Track Manager > Current Track


[image: ]

3/ Lưu lại Track hiện tại:

a/ Từ Menu chính, chọn Current Track hoặcTrack Manager > Current Track
[image: ]b/ Chọn 1 trong 2 kiểu lưu sau:
· [image: ]Bấm vào biểu tượng	để Save Track : lưu lại tòan bộ track
· Bấm vào	chọn Save Portion: cho phép bạn lưu lại một đọan nào đó của track

4/ Reset Track hiện tại (Current Track)
Vì máy có tính năng tự động ghi lại toàn bộ đoạn đường đã đi qua, trong đó có những đoạn đường mà ta không cần đến. Đặc biệt, đối với những máy Garmin thế hệ mới, nó có tính năng tự động nối điểm đầu của Track này với điểm cuối của Track tiếp theo (mặc dù giữa 2 lần đo ta đã tắt máy). Vì vậy, để tránh tình trạng các Track này dính chùm với nhau, trước khi tiến hành đo ta nên xóa những Track tạm thời này đi, việc xóa những Track này không ảnh hưởng gì đến những Track đã lưu trước đó. Thao tác như sau :
Chọn Track Manager  > Current Track > Clear current Track [image: ]  > Clear Hoặc: từ Menu chính, chọn Setup > Reset > Clear Current Track > Clear 5/ Xóa 1 Track đã lưu trong máy:

· Từ Menu chính, chọn Track Manager
· Chọn track mà ta cần xóa



· Chọn

> Delete > Delete


[image: ]CÁC CHỨC NĂNG CHÍNH


I. CHỨC NĂNG DẪN ĐƯỜNG:

Thiết bị này có thể dẫn bạn đi đến bất kỳ tọa độ điểm, hình ảnh nào đã lưu trong máy hoặc đi theo Track, hành trình mà bạn đã tạo ra.

Từ màn hình Menu chính, chọn Where To ? Máy sẽ liệt kê ra các tùy chọn sau:
[image: ]

· Waypoint: chọn Waypoint mà bạn cần đi đến. Sau đó chọn Go
· Photos : chọn một hình ảnh mà bạn cần đi đến > chọn Go
· Track : chọn một Track mà bạn cần đi > chọn Go
· Route: chọn 1 hành trình mà bạn muốn đi > chọn Go, máy sẽ dẫn bạn đến điểm khởi hành của hành trình và sau đó đi theo hành trình mà bạn đã lập trước đó.
· Geocaches: dẫn đường đến một vị trí, địa danh đã được lập sẵn.
· [image: ]Coordinates: Dẫn đường đi đến 1 điểm mà ta biết tọa độ của điểm đó, sau khi chọn Coordinates, ta có màn hình như bên dưới. Dùng các chữ số để nhập tọa độ
mới vào, xong chọn	để lưu lại. Trên màn hình sẽ xuất hiện một đường thẳng
nối từ điểm ta đang đứng đến điểm mà ta vừa nhập tọa độ vào.


[image: ]
Sau khi chọn một	trong	các
tùy chọn trên và chọn lệnh Go. Trên màn hình bản đồ sẽ hiện ra một đường thẳng nối từ nơi ta đang đứng đến điểm mà ta cần đi đến. Nên thoát khỏi màn hình bản đồ để chuyển sang màn hình la bàn (chọn Compass) và di chuyển theo hướng chỉ của la bàn. Trên màn hình này, ta cũng có thể thấy các thông số như tốc độ đang di chuyển, khỏang cách và thời gian đến đích.

Khi về đến đích, máy sẽ phát ra một tiếng beep và trên màn hình sẽ hiện ra dòng chữ
Arriving At “tên điểm”.
[image: ]





[image: ]Để dừng chức năng dẫn đường: chọn Where
To ?, chọn Stop Navigation



II. CHỨC NĂNG TÍNH DIỆN TÍCH MỘT KHU VỰC:

Trước khi đo một khu vực nào đó, ta nên
dung  lệnh  Clear Current Track.  Việc  này giúp
cho hình dáng các khu vực không dính liền nhau, máy sẽ cho ta thấy vị trí và hình dáng của từng khu vực riêng biệt. Việc xóa Track này không ảnh hưởng gì tới những Track mà bạn đã lưu trước đó.Thao tác như sau :từ màn hình Menu chính:

Chọn Track Manager > Current Track > Clear Current Track > Clear














[image: ]























	Thao tác đo diện tích:

· Vào Area Calculation > Start
· Đi vòng quanh khu vực mà bạn muốn đo
· Chọn Calculate khi bạn đi đến điểm cuối cùng (phải trùng với điểm xuất phát)


[image: ]

Sau khi ấn Calculate, sẽ có các màn hình sau:

[image: ]



· Chọn Save Track để lưu lại track này
· Chọn Change Units để đổi các đơn vị đo lường (hecta, m, km,..)


Để xem diện tích và chu vi của một Track đã lưu trước đó:


· Từ màn hình Menu chính, vào Track Manager
· Chọn 1 Track mà bạn cần xem
-	Chọn View Map, hình dáng của Track cần xem sẽ hiển thị trên bản đồ.
-	Chạm vào tên của Track (trên đỉnh của màn hình): chu vi (chiều dài) và diện tích của Track đó sẽ hiện ra.


Xem chuổi hình minh hoạ dưới đây :


[image: ]


[image: ]


CÁC TÍNH NĂNG KHÁC

Môt số công cụ thường sử dụng trên màn hình Menu chính:

1/ Calendar: Hiển thị lịch, đồng thời cho ta biết số Waypoint, Track mà ta đã lưu được trong một ngày nào đó.

2/ Sun and Moon: cho biết thời gian mặt trời, mặt trăng mọc và lặn trong ngày tại vị trí mà bạn đặt máy.



[image: ]



3/ Hunt and Fish: cho biết lịch vệ tinh tốt nhất trong ngày tại vị trí đặt máy

Muốn xem lịch vệ tinh của ngày khác thì di chuyển vệt sáng đến ngày đó. Khi đó lịch vệ tinh cũng thay đổi theo tương ứng.
[image: ]


4/Trip Computer:



[image: ]Chức  năng  này  dùng  để  đo
chiều  dài  của  quảng  đường
thực tế mà bạn đã đi (không
phải đường chim bay).

Ngoài ra  nó cũng  hiển thị tốc
độ  bạn  đang  di  chuyển, tốc
độ trung  bình,  tốc  độ tối đa,
chiều dài quảng và những thông số khác.


Trước khi khởi hành, để có những thông tin chính xác hơn, ta nên đưa tất cả các giá trị ở
màn hình này về = 0. Thao tác như sau:

[image: ]Chọn Reset > Reset Trip Data > Reset











5/	Proximity
Alarms: chức năng này chủ yếu dùng để cảnh báo. Máy sẽ báo động khi ta đi vào phạm vi của một vùng nào đó do ta cài đặt trước. Vi dụ như bãi bom mìn, vùng ô nhiểm phóng xạ, dãy đá ngầm,…
Từ màn hình menu chính, chọn Proximity Alarms > Create Alarm
Trên màn hình sẽ xuất hiện các tùy chọn để làm tâm cho vùng cần cảnh báo. Thông thường ta dùng bản đồ (Use Map) hoặc tọa độ (Waypoints) .
Sau khi chọn xong điểm cần cảnh báo từ danh sách các waypoint hay trên bản đồ, tiếp tục chọn Use, sẽ xuất hiện màn hình như dưới đây:



[image: ]

Chú ý: đơn vị tính mặc định ở đây là mile (1 mile = 1609 mét) nhưng trước khi cài đặt cảnh báo, ta có thể đổi ra đơn vị mét

Có thể hiểu điểm mà bạn muốn cảnh báo là tâm của 1 vòng tròn, khoảng cách mà bạn muốn cài đặt là bán kính của vòng tròn. Khi ta đi vào phạm vi của vòng tròn đó, máy sẽ báo động.


6/ Share Wireless (Chia sẽ dữ liệu)

Montana 650 có khả năng chia sẽ dữ liệu (Waypoint, Track, Route,…) bằng công nghệ Bluetooh với những thiết bị Garmin tương thích khác.

· Đặt 2 thiết bị gần nhau trong phạm vi 3 mét
· Trên màn hình Menu chính của 2 thiết bị, chọn Share Wireless
· Trên thiết bị nhận dữ liệu, chọn Receive.
· Trên thiết bị gởi dữ liệu, chọn Send
· Trên thiết bị gởi, chọn loại dữ liệu mà ta cần gởi > chọn Send một lần nữa
· Khi trên màn hình của máy gởi và nhận hiển thị sự chuyển dữ liệu đã hòan tất > OK
trên cả 2 thiết bị.


TRUYỀN DỮ LIỆU VÀO MÁY TÍNH


Để truyền dữ liệu từ máy Garmin GPS vào máy tính đối với dòng máy Montana, Oregon,

78 seri, 62 seri, eTrex 10-20-30 ….ta có thể sử
Basecamp.

dụng 2 phần mềm là

Mapsource và

Phần mềm Basecamp có ưu điểm là tự động trút tất cả dữ liệu từ máy GPS vào máy tính khi có kết nối giữa máy GPS và máy tính; và cho phép xuất dữ liệu ở định dạng “.*csv” là định dạng có thể mở trong excel để xử lý sau đó mở được trong Mapinfo.
Phần mềm Mapsource có ưu điểm là cho phép xuất dữ liệu ở định dang “.*dxf” là định dạng có thể mở trực tiếp trong AutoCad và xuất dữ liệu bằng import vào trong Mapinfo.

Ngoài ra, cả 2 phần mềm đều có ưu điểm cho phép xuất dữ liệu được ở notepad; excel.
· 
dạng

“*.txt” mở


Ghi Chú : Yêu cầu cấu hình máy tính phải :

· Windows XP Service Pack 3 hoặc mới hơn là bắt buộc.
· 2 GB bộ nhớ hệ thống được khuyến cáo.

· Muốn xem chế độ 3D, phải có mới hơn là cần thiết.

card màn hình hỗ trợ OpenGL phiên bản 1.3 hoặc


Cài đặt phần mềm MapSource và cài đặt phần mềm Garmin BaseCamp

· Gắn cáp truyền USB vào máy GPS và máy tính.
· Tim đến thư mục Garmin, kích đúp vào và chọn File cài đặt.
Trong File cài đặt có hai phần mềm Mapsource và Basecamp. Coppy File cài đặt này ra máy tính và bắt đầu kích đúp vào nó để cài. Theo hình sau:



[image: ]

Các bước tiến hành truyền dữ liệu dùng phần mềm Basecamp

Bước 1: Mở máy GPS, gắn cáp truyền USB vào máy GPS và máy tính.

Bước 2: Khởi động phần mềm Basecamp.

Dữ liệu từ máy GPS sẽ tự động truyền vào Basecamp. Dữ liệu truyền vào sẽ ở trong
Internal Storange. Ta được như sau:
[image: ]

Bước 3: Cài đặt các thông số phần mềm Basecamp:

Trên Garmin Basecamp, chọn Edit, chọn Options.., kích chọn Measurement.
+ Cài đặt đơn vị đo ở ô Measurement System (chọn metric).

+ Cài đặt Position để chọn cách thể hiện tọa độ các điểm theo kinh độ, vĩ độ (chọn
Lat/Lon hddd0 mm.mmm’ ), hoặc tọa độ UTM (met), hoặc VN2000.
[image: ]
Bước 4: Lưu dữ liệu trên máy tính:

Từ màn hình Basecamp, chọn File, chọn Export, chọn Export Internal Storage nếu muốn lưu toàn bộ dữ liệu vừa mới chuyển từ máy GPS vào hoặc Export Selection để lưu dữ liệu được chọn…được màn hình:
[image: ]

-	Đặt tên file cần lưu (File name) và chọn kiểu dữ liệu lưu (Save as type):


+ Garmin GPS Database Files (*.gdb): dữ Mapsource.

liệu chạy được trên Basecamp,

+ GPS exchange Format (*.gpx): dữ liệu chạy được trên Basecamp, Mapsource.
+ Comma- delimited text (*.csv) : dữ liệu chạy được trên Excel.

+ Tab delimited (*.txt) : dữ liệu chạy được trên Notepad, Excel.


Các bước tiến hành truyền dữ liệu dùng phần mềm Mapsource

Bước 1: Mở máy GPS, gắn cáp truyền USB vào máy GPS và máy tính.

Bước 2: Khởi động phần mềm Mapsource, ta có màn hình:
[image: ]

Có 3 cách xuất dữ liệu từ GPS vào Mapsource:

· Cách 1: Vào Transfer\Receive From Device…


· Cách 2: Chọn vào biểu tượng máy GPS trên Toolbar (chỗ khoanh tròn đỏ)




Xuất hiện cửa sổ sau:
[image: ]

Nếu ô Device chưa sáng lên và chưa hiển thị Model của thiết bị GPS nghĩa là máy tính và máy GPS chưa kết nối, ta phải kiểm tra lại dây cáp kết nối.
Sau khi máy tính hiểu được máy GPS, chọn những ô dữ liệu muốn truyền từ máy GPS vào máy tính: Maps (bản đồ); Routes (hành trình); Waypoint (điểm tọa độ); Tracks (lưu vết đường đi) để chuyển những dữ liệu này vào máy tính.
Chọn Receive, được thông báo:
[image: ]
Chọn OK kết thúc việc truyền dữ liệu.

· Cách 3: Cách lấy dữ liệu thủ công
Từ màn hình Waypoint, vào File, chọn Open, tìm đường dẫn đến thư mục chứa ổ đĩa GARMIN, vào Garmin, vào GPX, và chọn waypoint, track,… cần chuyển, kích chọn open.

Dưới đây là hình các bước chuyển dữ liệu thủ công:



[image: ]

Tìm đường dẫn đến thư mục chứa ổ đĩa GARMIN:
[image: ]

Vào Garmin, vào tiếp GPX:


[image: ]

Chọn waypoint, track,… cần chuyển, kích chọn open:
[image: ]

Kết quả thu được trên Mapsource:


[image: ]

Chú ý:
Khi dùng Mapsource để truyền dữ liệu, Mapsoure không cho phép chuyển tải tự động Waypoint vào máy tính đối với dòng máy Oregon, 78 seri, 62 seri, eTrex 10-20-30 như những dòng máy trước. Do đó, cách 1 và 2 chỉ chuyển được tracks và routes. Để khắc phục nhược điểm này nên dùng Basecamp để truyền dữ liệu, hoặc nếu dùng Mapsource thì dùng cách 3 để truyền các điểm Waypoint.

Bước 3: Cài đặt các thông số phần mềm Mapsource:

· Từ màn hình Mapsource, chọn Edit, chọn preferences…
[image: ]

· Chọn Unit để cài đặt đơn vị đo (chọn đơn vị metric).
[image: ]

· Vào Position để chọn cách thể hiện tọa độ các điểm theo kinh độ, vĩ độ (chọn
Lat/Lon hddd0 mm.mmm’ ), hoặc tọa độ UTM (met), hoặc VN2000.
· Vào Waypoint để cài đặt biểu tượng (symbol), chiều dài tên điểm,…
Bước 4: Lưu dữ liệu trên máy tính:

[image: ]Từ màn hình Mapsource, chọn File, chọn Save as…Xuất hiện màn hình:

· Đặt tên file cần lưu và chọn kiểu dữ liệu lưu (Save as type):

+ Garmin GPS Database (*.gdb): dữ liệu chạy được trên phần mềm Basecamp.
+ MPS files (*.mps): dữ liệu chạy được trên phần mềm Mapsource.
+ Text ( Tab delimited (*.txt)) : dữ liệu chạy được trên Notepad, Excel.

+ DXF (*.dxf) : dữ liệu chạy được trên phần mềm AutoCad hoặc Import xuất dữ liệu được sang phần mềm Mapinfo.

Chú ý cách chuyển file sang đuôi file “ *.dxf “:

Khi lưu dữ liệu  ở định dạng *.dxf và muốn lưu  ở  hệ tọa độ UTM phải xóa bỏ tất cả
những Waypoint  có  sẵn  trên  máy  như BirdsEye  Demo,  Garmin Asia,  Garmin Europe,
Garmin USA, Garmin_Asia, Garmin_Europe, Garmin_USA, Grand Canyon National Park… (nếu có) trước thì mới chuyển được, nếu không xóa sẽ báo lỗi.
Trên Mapsource chọn File - >Chọn Save as ->Chọn ổ đĩa cần lưu (Save in) -> chọn tên file (File name) ->Chọn đuôi file * dxf (Save as type) -> OK. Hình các bước lưu dữ liệu sang *.dxf :
[image: ]	[image: ]
Lưu ý: Vệ sinh máy sau mỗi lần sử dụng và tháo pin ra khỏi máy nếu không sử dụng trong thời gian dài. Trong trường hợp bị hư hỏng liên hệ với nhà cung cấp được sửa chữa - bảo hành chính hãng, không nên tự ý tháo rời.
Máy đạt tiêu chuẩn chống thấm IPX7, có thể chịu được trong nước ở độ sâu 1 mét trong vòng 30 phút. Tuy nhiên, trong quá trình sử dụng nên hạn chế tiếp xúc với nước. Nếu chẳng may làm rơi xuống nước nên lau khô trước khi đem bảo quản


DANH SÁCH KINH TUYẾN GỐC CÁC TỈNH THÀNH CỦA HỆ TỌA ĐỘ VN 2000

	TT
	Tỉnh, thành phố
	Kinh tuyến trục
	TT
	Tỉnh, thành phố
	Kinh tuyến trục

	1
	Lai Châu
	1030 00’
	33
	Long An
	1050 45’

	2
	Điện Biên
	1030 00’
	34
	Tiền Giang
	1050 45’

	3
	Sơn La
	1040 00’
	35
	Bến Tre
	1050 45’




	4
	Kiên Giang
	1040 30’
	36
	Hải Phòng
	1050 45’

	5
	Cà Mau
	1040 30’
	37
	TP. Hồ Chí Minh
	1050 45’

	6
	Lào Cai
	1040 45’
	38
	Bình Dương
	1050 45’

	7
	Yến Bái
	1040 45’
	39
	Tuyên Quang
	1060 00’

	8
	Nghệ An
	1040 45’
	40
	Hòa Bình
	1060 00’

	9
	Phú Thọ
	1040 45’
	41
	Quảng Bình
	1060 00’

	10
	An Giang
	1040 45’
	42
	Quảng Trị
	1060 15’

	11
	Thanh Hóa
	1050 00’
	43
	Bình Phước
	1060 15’

	12
	Vĩnh Phúc
	1050 00’
	44
	Bắc Kạn
	1060 30’

	13
	Hà Tây
	1050 00’
	45
	Thái Nguyên
	1060 30’

	14
	Đồng Tháp
	1050 00’
	46
	Bắc Giang
	1070 00’

	15
	Cần Thơ
	1050 00’
	47
	Thừa Thiên – Huế
	1070 00’

	16
	Hậu Giang
	1050 00’
	48
	Lạng Sơn
	1070 15’

	17
	Bạc Liêu
	1050 00’
	49
	Kon Tum
	1070 30’

	18
	Hà Nội
	1050 00’
	50
	Quảng Ninh
	1070 45’

	19
	Ninh Bình
	1050 00’
	51
	Đồng Nai
	1070 45’

	20
	Hà Nam
	1050 00’
	52
	Bà Rịa – Vũng Tàu
	1070 45’

	21
	Hà Giang
	1050 30’
	53
	Quảng Nam
	1070 45’

	22
	Hải Dương
	1050 30’
	54
	Lâm Đồng
	1070 45’

	23
	Hà Tĩnh
	1050 30’
	55
	Đà Nẵng
	1070 45’

	24
	Bắc Ninh
	1050 30’
	56
	Quảng Ngãi
	1080 00’

	25
	Hưng Yên
	1050 30’
	57
	Ninh Thuận
	1080 15’

	26
	Thái Bình
	1050 30’
	58
	Khánh Hòa
	1080 15’

	27
	Nam Định
	1050 30’
	59
	Bình Định
	1080 15’

	28
	Tây Ninh
	1050 30’
	60
	Đắc Lắc
	1080 30’

	29
	Vĩnh Long
	1050 30’
	61
	Đắc Nông
	1080 30’

	30
	Sóc Trăng
	1050 30’
	62
	Phú Yên
	1080 30’

	31
	Trà Vinh
	1050 30’
	63
	Gia Lai
	1080 30’

	32
	Cao Bằng
	1050 45’
	64
	Bình Thuận
	1080 30’
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